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Starting Announce!

You can start Announce! from either Windows Program Manager, Windows File Manager or the 
command prompt.

To start Announce! from the Windows Program Manager

1 Switch to the Program Manager window.

2 Open the group window that contains the Announce! icon.

3 Do one of the following:

Double-click the Announce! icon.

Use the arrow keys to select the Announce! icon, and then press ENTER.

To start Announce! from the Windows File Manager

1 Do one of the following:

Locate the ANNOUNCE.EXE file and double click on the icon.

Double click on a file with the    VAP, or VOX extension.



The Announce! desktop

The Announce! desktop consists of 3 areas:

1) The ToolBar 

The ToolBar is a horizontal row of buttons designed to give you fast and easy access to the most 
commonly used functions.

2) The Main Desktop, where the child windows are located

Announce! provides three different types of windows on the desktop:

voice editor windows 

phrase list windows 

3) The StatusBar 

The StatusBar provides information about the current state of Announce!, and about the currently 
selected phrase or phrases. 

Making an open window active

A window must be active before you can work in it. Announce! highlights or shades the window border 
and title bar of an active window.

From the Window menu, choose the document window that you want to make active (ALT, W, name).

Arranging windows

When several windows are open at the same time., the workplace can get cluttered. Select the 
Cascade or Tile menu items in the Window menu to rearrange your windows so they are all visible.



Voice editor windows

Voice editor windows provide a graphical display of a waveform. The display scale can be adjusted 
both in the x and y directions, so that any waveform can be viewed regardless of length or amplitude. 
A scale on the left hand side provides an indication of amplitude, together with the maximum allowed 
values for ADPCM and 16 bit samples. The x scale indicates time, in milliseconds or seconds as 
appropriate.

Setting a new cursor position

Click in the window to set the cursor to a new position. The cursor is the position where new samples 
are inserted when using the paste command and insert menu commands.

Selecting part of a waveform

Drag the mouse in the window to select part of a waveform. A purple rectangular box will show 
graphically the sample selected, and the StatusBar will show the start and duration of the selection in 
milliseconds. Alternatively, to make a large selection, click in the window at the desired selection 
starting point, and then click again at the desired end point while pressing the Shift key.

Most effect menu commands will operate on the selection, if there is one. Otherwise the commands 
will operate over the whole phrase.

Adjusting the x and y scale of the waveform display

Use these buttons to change the vertical scaling of your waveform

Use these buttons to change the horizontal scaling of your waveform



Phrase list windows

Phrase list windows show a list of phrases. Each phrase entry consists of 3 parts:

1. an icon showing the phrase type.     .

2. the current format of the phrase (LN for linear, AD for ADPCM)

3. a name for the phrase. 

4. an icon representing the attached filename for this phrase. The filename is used when saving 
each phrase to a separate file - useful for applications that require each prompt in a separate file.

This is a long phrase name ...
Double click on the phrase icon to play the phrase.

Click on the ellipses ... to see all of a filename that does not fit on one line

Double click on the name to edit the phrase name.

Drag the icon onto the desktop to edit the phrase.

Drag the icon into another window to copythe phrase.

Drag the icon into a new position in the same window or another phrase list window to copy the 
phrase.

See also

Working with phrases 



The ToolBar

Click on the buttons above to get a description of each button.
If the mouse is moved over an active Announce! ToolBar button, the INFORMATION field in the status bar 
will remind you what action that would be performed by this button. If the button is not active for this 
window, the INFORMATION field will be blank. 



The StatusBar

StatusBar fields

INFORMATION field

Shows the current status of Announce!.

If the mouse is moved over a ToolBar button, the INFORMATION field will show the action that would 
be performed by this button. If the button is not active for this window, the field will be blank. If you 
mouse down on a menu item, the INFORMATION field will show a more detailed description of the 
menu item. If you drag a phrase or phrases from a phrase list window. the INFORMATION field will 
remind you of the action Announce! will take if your release the mouse button at that point.

CURSOR field

In a phrase list window:

Shows the offset into the file of the first phrase of the selection 

In a Voice Editor window:

Shows the start position in milliseconds of the beginning of the current selection

SIZE field

In a phrase list window:

Shows the duration in milliseconds of the selected phrase. If more than one phrase is selected, 
this field is blank

In a Voice Editor window:

Shows the duration in milliseconds of the selected samples.

RATE field

This field shows the sampling rate of the currently selected phrase in a phrase list, or the 
sampling rate of the phrase in a voice editor window. Pressing the RATE button will popup a 
dialog to allow you the change the sampling rate of the selected samples or phrase. See 
SampleRate



Overview
Announce! is a program that provides a multi-windowed environment for creating and editing voice 
prompts for voice mail and voice response systems. Announce! can read many different file formats, 
and can do voice processing to ensure high quality prompts. The graphical environment, drag-drop 
features and integration with Windows sound capabilities allow easy visualization and processing of 
the speech.

Announce! works with cards designed for voice response systems, and with Windows 3.1 sound 
cards. Using a sound card enables cost-effective high quality prompts by recording at 16 bits, either 
at the final sampling rate or at a higher intermediate sampling rate. Sound cards usually have extra 
features like an audio mixer and audio player inputs not available on voice cards. MIDI output can 
also be used to generate background music for prompts.

All the facilities of Announce! are available if you do not have a Windows sound card, with the 
exception of real-time silence detection during record. However when recording from a voice card, 
this is not a requirement since compressed speech takes up much less disk space, and the recorded 
phrases can easily be split up into phrases later. Announce! has a command that will remove extra 
silence from a list of phrases.

Announce! works with 16 bit samples during voice processing, and keeps voice data in this format 
until saved by the user as compressed ADPCM. This increases speed of operation, and improves 
quality by removing unnecessary ADPCM conversions. 16 bit samples have a greater dynamic range 
than ADPCM, allowing for temporary peaks during voice processing that might be clipped if using 
ADPCM. 

Where possible, Announce! uses fixed-point arithmetic for calculations in order to improve 
performance on systems that do not have a floating-point coprocessor.

Announce! has a bulk processing capability that sets it apart from other voice editors. In Announce!, if 
you want to add, say Echo to all your prompts, you just select all the prompts in your window with 2 
mouse clicks, and then select the Echo command. Announce! will take care ot the rest. Compare this 
to loading in 150 files, configuring and executing the echo command for each one, and then saving 
each file



Starting a new project

First, plan your phrases and subphrases.

Second (very important!) ensure you have enough disk space. Unprocessed voice files take up many 
megabytes of disk space, especially if recording in linear format, and/or without silence detection.

There are 2 basic methods of recording phrases:

recording from a pre-recorded tape 

recording each phrase yourself interactively in front of the computer .

See also:

Naming phrases 

Record Dialog 



Recording new phrases
There are 2 basic methods of recording phrases:

1) recording from a pre-recorded tape 

2) recording each phrase yourself interactively in front of the computer .

See also:

Naming phrases 

Record Dialog 



Recording from tape
Recording from tape allows high quality recordings to be made in a recording studio or other quiet 
location (away from computer fans and other extraneous noises), and then loaded into the computer 
later on. This also is an economical method to use when using professional announcers. This method 
does have the disadvantage that any flaws in the recording may require a new recording session. It is 
often advisable to record at least 2 copies of each phrase.

Procedure using a Windows sound card

Connect the tape machine into the appropriate input on your sound card.

Open a new phrase file window. (See New    or Open    command)

Select Record from the Sound Menu. (See Record    command)

Start the tape playing and monitor sound levels. Sound levels should not exceed -6db to allow for 
peaks. The meter in the dialog will show incoming sound levels.

Use the silence detect scroll bar to set the silence detect threshold above the noise level between 
phrases, but well below the maximum phrase level. If the silence detect threshold is set too high, the 
start and end of phrases may get cut off. If the silence detect threshold is set too low, noise may be 
detected as speech with erroneous results.

Now start recording by pressing the start button in the dialog. The silence detector should start 
searching for silence. Once a silence period has been detected, it will wait for the first non-silence and 
start recording the first phrase.

 At the end of phrase it will load the phrase into the window display, and start searching for the next 
phrase. If the pauses between phrases are too close, the silence detector may not detect the silence 
and may record 2 phrases into 1 phrase in the file. This is not a serious problem since the phrases 
can be split later (using Split Phrase in the Phrase Menu). 

Reducing the silence detect time in the Record Setup menu may also help. Note that phrases with 
multiple sentences (i.e. press 1 for this, <pause> press 2 for that) can have pauses that approach one 
second. 

Your recordings should be made with pauses of at least 2 seconds between phrases to ensure that 
phrases can be recorded as intended.

Once the system appears to be adjusted correctly, open a new phrase file, start record and start the 
tape running.

Allow several phrases to be recorded and then check for sound quality and correct phrase splitting. If 
the end of phrases are being cut off, try reducing the silence threshold. 

Once your phrases are recorded, save the file, and you are then ready to start editing your phrases

Procedure using a voice card

There are two methods of creating a series of phrases from a tape using a voice card: 

The best method is to make a large recording of many phrases into a single file, and then split up the 
phrase using silence detection. The recording must have two or three seconds minimum silence 
between each phrase to achieve correct splitting. 

Another method is to record each phrase manually by starting and stopping both the record process 
in Announce! and the tape machine. This option can be time consuming.

To make a bulk recording of many prompts, use the following procedure:

Open a new phrase file window. (See New    or Open    command)

Connect the tape machine into the appropriate input on your voice card. 



Check VoiceCard    to ensure you have configured the voice card to record from the input you are 
using,and to set a maximum silence time to 0 to disable silence termination.

Select Record from the Sound Menu. (See Record ).

Start recording by pressing the start button in the dialog, and start the tape. Wait for several phrases 
to be recorded, stop the tape, and press the stop button in the dialog. A new phrase should be loaded 
into the Phrase window. 

Close the record dialog and select the newly recorded phrase.

Select Split Phrase from the Phrase Menu. This will scan the phrase for silence and automatically 
split the phrase into smaller phrases. Announce! will report the number of phrases found, and the 
longest phrase. Multiple passes can be made if required, each using more sensitive silence detection. 

Once the level has been adjusted correctly, the tape can be allowed to run to record all the phrases.



Interactive Recording
Recording prompts while interacting with Announce! is a useful method if you are using your own 
voice to record the prompts. You will be able to monitor progress and correct problems as you go.

A similar procedure can be used for both voice cards and sound cards:

Recording phrases in a phrase list

Select the first phrase in the list of phrases to be recorded, and press the record button. Announce! 
will show you the Record dialog and show the script for the first phrase to be recorded. 

Recording from a sound card:

You will be able to press the AutoRecord button. Announce! will now start its speech detection 
process. When you start to speak, Announce! will start saving data to disk. When you stop, 
Announce! will save the phrase and display the next script to be recorded. You may need to adjust 
the silence detection level to ensure that the phrases are recorded correclty.

If you want to rerecord a phrase, press Last to back up to the required phrase and try again.

If you wish, you can use a manual start/stop method as described for voice cards below

Recording from a voice card:

Press the record button to start recording the phrase. You can press stop to terminate the recording 
or wait for silence detection to stop it for you. Press Next to move on to the next script to record, and 
then repeat the process.

Recording a phrase in a voice edit window

Position the cursor in the window where you want to start recording and press the record button. 
Announce! will show you the Record dialog. 

Recording from a sound card:

Select the silence detection check box and press the Record button. Announce! will now start its 
speech detection process. When you start to speak, Announce! will start saving data to disk. When 
you stop, Announce! will save the phrase. You may need to adjust the silence detection level to 
ensure that the phrases are recorded correctly. Press OK to return to the voice edit window, or 
Record again to record some more speech.

Recording from a voice card:

Press the Record button to start recording. Press the stop button to terminate the recording or wait for 
the voice card to detect silence. Announce! will then save the phrase. If your voice editor window is 
set to a different sampling rate from your voice card, Announce! will do a sampling rate conversion 
before saving the data.    Press OK to return to the voice edit window, or Record again to record some 
more speech.



Step-by-step Instructions

Announce! is a multi-windowed environment for creating and editing voice prompts for voice mail and 
voice response systems. The graphical environment allows easy visualization and changing of the 
speech.

Starting Announce! 

The Announce! desktop 

File Formats 

Creating a new project from scratch

Creating a new project from existing files 

Recording new phrases 

Working with phrases 

Voice processing 



Creating a new project from scratch

If this is the first time you have needed to create a list of voice prompts, or if you wish to create a set 
of prompts from scratch, you will probably only have a list of the prompts, and possibly, a list of file 
names to save the files into. Announce! allows you to group a list of phrases into a project while you 
work on them to give you easy access to all your prompts. This simplifies cutting and pasting between 
prompts, and allows easy concatenation of prompts to check for smooth flow of phrases made up of 
several words or subphrases. 

Once editing is complete, Announce! will save the phrases into the file format of your choice. You can 
store the original phrases in linear format to ensure no loss of quality if further editing is required.

If you already have some voice prompts, and wish to add to them, or change them, see also Creating 
a new project using existing files .

To open a new project, select New    from the File Menu, and select New Phrase File from the dialog. 
An empty window will be created, into which you can record phrases. You can create phrases by 
recording from a Windows sound card or a voice card.

You can add existing files to your project by dragging them from the File Manager onto the Announce! 
desktop or onto a Phrase List or Voice Editor window, or by using the Import Voice command from the 
Phrase menu. You can import VOX (compressed ADPCM) files, WAV (Windows Sound) files, and LIN 
(16 bit Linear) files.



Editing an existing voice file

If you have a specific voice prompt that you wish to edit, choose Open    from the File Menu, and 
select the appropriate file-type in the file type drop-down selection box. The default extension for 
compressed ADPCM files is VOX. Announce! will assume that the file has been compressed in the 
ADPCM format used by your voice card, as configured in the Voice Card Setup in the Sound menu.



Creating a new project from existing voice files

You have already created some voice prompts, and you wish to import them into Announce! for 
further editing or additions. The easiest way to import a large number of prompts into Announce! is to 
use the drag-drop feature of File Manager.

First, resize both File Manager and Announce! so that both your new phrase list window and the 
directory in File Manager where your phrases are stored are not overlapped. Select all the phrases 
you wish to import, using shift -click and /or control-click. Now click the mouse on one of your selected 
files, drag the files onto the Announce! desktop, and release the mouse button.

Announce! will read the files and ask you if you want to create a new Phrase List. Click the Yes 
button, and Announce! will load them as phrases into the phrase list window. If Announce! is not sure 
of the file type, it will assume compressed ADPCM format of the type used by your voice card.

Alternatively, you can create an empty project by selecting New    from the File Menu, and select New 
Phrase File from the dialog. An empty window will be created, into which you can add phrases. You 
can add existing files to your project by dragging them from the File Manager, or by using the Import 
Voice    command from the Phrase menu. You can import VOX (compressed ADPCM) files, WAV 
(Windows Sound) files and LIN (16 bit Linear) files.

You can also edit your phrases directly into a Voice Editor window, and copy all or part of them to the 
clipboard using the Copy command, and then the Paste command to paste them into your phrase file 
window.



Working with phrases

Once you have a phrase window containing your phrases, you will want to test them and modify 
them.

Selecting phrases 

Copying phrases 

Moving phrases 

Playing phrases 

Editing phrases 

Naming phrases 

Using Phrase Filenames 

Editing your phrases 



Selecting phrases

To select a phrase in a phrase file window, click on it.

To select a number of phrases, click on the first phrase in your desired selection, and the press the 
Shift key and click on the last phrase in your selection. All the phrases will now be selected.

Most phrase and effects commands will work both on single selections and multiple selections.

To unselect a selection, click again in the window.



Copying phrases

To copy a phrase or list of phrases to a new location, use the drag-drop feature of Announce!. Click 
the mouse over the phrase you want to move, drag the mouse to the new position, and release the 
mouse. The new phrase will be named Copy of ...<original name>. Note Announce! uses the phrase 
name to distinguish amongst phrases so all names in a phrase window must be unique. Phrase 
names are of unlimited length.

Another method is to use the Copy    command (Edit Menu) to copy the selection to the clipboard, 
moving to the new location, and then selecting Paste (Edit Menu) to move the selection to the new 
location.

Using copy - paste will allow you to copy phrases into a Voice Editor window and to copy all or part of 
a phrase from a Voice Editor window into a new phrase in a Phrase File window.

Announce! will use the StatusBar information field to remind you as you drag the icon over the screen 
what will happen if the mouse button is released at that point.

You can also insert a phrase into a voice editor window by dragging it over the voice editor window, 
The phrase will be inserted at the cursor position.



Moving phrases
To move a phrase to another location without copying it, you can use the drag-drop feature of 
Announce!. Click the mouse over the phrase you want to move, drag the mouse to the new position, 
press the Control key and release the mouse.

You can move phrases both within a window, and between windows. In addition, if you drop a phrase 
onto the Announce! desktop, Announce! will open up a voice editor window on that phrase.

Another method is to use the Cut    command (Edit Menu) to copy the selection to the clipboard, 
moving to the new location, and then selecting Paste    (Edit Menu) to move the selection to the new 
location.

Announce! will use the StatusBar information field to remind you as you drag the icon over the screen 
what will happen if the mouse button is released at that point.



Naming phrases

 This is a long phrase name 

If an name does not fit in one line in the phrase list window, Announce! will show the name terminated 
by ellipses. Click on the ellipses  to see all of a filename that does not fit on one line

To name a phrase, use the Edit Name    command.
If you have a large number of phrases, and you have a text file containing the names for these phrases, 
you can set the phrase names from the text file by using the Load Scripts from File    menu command. 
Announce! will prompt you to select the text file, and will use successive lines of this text file as names for 
your phrases. This file can be created using a text editor such as Notepad from a list of names you 
already have, or you can save the existing names into a text file using the Save Scripts from File    
command.



Using Phrase filenames
Each phrase or group of subphrases has an attached filename. This filename is used to save the 
phrase into an individual voice file for voice applications that require separate voice files for each 
prompt. Announce! will save each phrase into the designated filename when you choose Save As 
Phrases from the File menu.

To see a phrase filename, click on the  icon.
To set the filename of a phrase, use the Edit FileName    command, or double click on the .
If you have a large number of phrases, and you have a text file containing the scripts for these phrases, 
you can set the phrase scripts from the text file by using the Load Filenames from File    menu command. 
Announce! will prompt you to select the text file, and will use successive lines of this text file as file names 
for your phrases. This file can be created using a text editor such as Notepad from a list of names you 
already have, or you can save the existing scripts into a text file using the Save Scripts to File    
command.

The drive, directory and file extension are assigned by the Save Phrases command and are not 
required in the filename. The file extension can be specified if required, if not specified the default file 
extension for ADPCM files will be used. (See Voicecard Setup 



Playing phrases

To play a phrase, select it with the mouse and click the play button, or double click on the icon    
 .

To play a list of phrases, first select all the phrases you wish to hear, and then click on the play button  
or select Play    from the Sound menu.

To stop a play operation, click on the button  , or select Stop    from the Sound Menu.
When playing to an 8 bit sound device, Announce! will warning if your waveform has exceeded the 
maximum value allowable.
If using a voice card, you may need to set a connection from another phone into your voice card. You can 
do this by dialling into the voicecard line before starting Announce!, since Announce! will go offhook as it 
starts. Alternatively, you can select Wait for Call at any time. Announce! will take the phone onhook and 
wait for an incoming ring and then answer the call.



Editing phrases

Announce! gives you many tools to edit and modify your phrases. In addition it allows bulk processing 
of all your phrases by allowing you to select one or all of them, and running the same command on all 

the selected phrases. For detailed editing of a waveform you can click the Edit Voice button        or 
choose Edit Voice    from the Phrase Menu, or simply drag the phrase onto the desktop.

See also

Voice Processing 



Voice processing

The voice processing commands (in the Effects menu) that you will find most useful will be the Pad 
Silence    and Clean Silence    commands. The Pad Silence command will remove silence or add extra 
silence if required so that all your phrases have the same amount of silence at the start and end of 
each phrase. The Clean Silence command will scan your phrases for pauses between sub-phrases or 
words, and will remove noise from these pauses.

The Louder/Softer    command will also be useful to set the correct amplitude for your phrases. 

The echo command can be used to good effect. Often a slight echo (1 echo, delayed 40 ms, -8db 
decay) is often enough to add more presence to your prompts. Like most of the effect commands, 
echo can be added to all of the phrases in a Phrase File window with one command.

For detailed editing. you can open up a voice editor window and use the loudness envelope 
command to fade in and out between words, and to adjust the level on a word-by-word basis.

Effect Menu

Pad Silence 

Clean Silence 

Filter 

Echo 

Fast/Slow 

Louder/Softer 

Loudness Envelope 

SampleRate 



Menu Commands

File Menu

New 

Open 

Close 

Save 

Save As 

Close All 

Exit

Edit Menu

Cut 

Copy 

Paste 

Clear 

Select All 

Edit Script 

Edit Filename 

Edit Voice 

Find 

Sort by Filename 

Sort by Script 

Insert Menu

Silence 

Tones 

Merge Clip 

Phrase Menu

Import Voice 

Compress 

Decompress 

Load Scripts from File 

Save Scripts to File 

Load Filenames from File 

Save Filenames to File 



Effect Menu

Pad Silence 

Clean Silence 

Filter 

Echo 

Fast/Slow 

Erase 

Louder/Softer 

Loudness Envelope 

SampleRate 

Sound Menu

Use voice card 

Use sound card 

Record 

Play Clip 

Play Selection 

Stop 

Wait for Call 

Play Repeat Mode 

Setup Menu

Sound Card 

Voice Card 

Font 

Waveform Display 

Waveform Colors 



New command (File menu)

Use this command to create a new voice editor window or phrase file window, or a new phrase in a 
phrase list.

You can open an existing document with 

the Open command.

Shortcuts

Toolbar:

Dialog Box Options
Select the type of new file you want to create.

New List Creates a new phrase file.

New Editor Creates a new voice editor window.

New Phrase Creates a new phrase in the currently active phrase file window. This 
option will only be available if the currently active window is a phrase file



Open command (File menu)

Use this command to open an existing phrase file or voice file in a new window. You can open as 
many windows as you like, subject to available memory. 

You can use the Window menu to switch among open documents.

If you have a document on your screen that you no longer want to use, choose the Close    command 
to close it. 

You can create new documents with the New    command.

Shortcuts

Keyboard Cntrl+F12

Toolbar:

Dialog Box Options

File Name

Type or select the filename you want to open. This box lists files with the extension you select in the 
List Files Of Type box.

List Files Of Type:

Select the type of file you want to open. Files of type VAP will be opened into a Phrase List Window. 
Files of type VOX, LIN, or WAV will normally be opened into a voice editor window. 

See Also File Formats 



Close command (File menu)

Use this command to close the active window. If you close a window without saving, you lose all 
changes made since the last save. Before closing an unnamed file, Announce! displays the Save As 
dialog box and suggests that you name and save the file.

If you are closing a phrase file, and there are voice editor windows open on one or more of the 
phrases in the window, Announce! will close the voice editor windows first. If changes have been 
made to these windows, Announce! will prompt you to save these changes.

You can also close a window by using the Close command on the document.

In order to improve speed of operation, cutting or copying phrases to the clipboard does not actually 
copy the data, but stores a pointer to the file. If the clipboard contains a pointer to data in the window 
that you are closing, Announce! will warn you with a dialog before proceeding if the current clipboard 
contents will be lost upon close.

Shortcuts

Keyboard Cntrl+F12

Double-click on the window close box (top left hand button of the window)



Close All command (File menu)

Use this command to close all windows. If changes have been made, Announce! will prompt you to 
save the data. Before closing an unnamed document, Announce! displays the Save As dialog box and 
suggests that you name and save the document.

You can also close a document by using the Close command on the document 



Save command (File menu)
Use this command to save the active file and the current name, location, and file format. When you 
save a file for the first time, Announce! displays the Save As dialog box so you can name your file. If 
you want to change the name, location, or format of an existing file, choose the Save As command.

Shortcuts

Keys: SHIFT+F12

Toolbar:



Save As command (File menu)
Use this command to save and name the active window with a specified file format.

Notes: 

To save a file with the existing name, format, and location, use the Save command.

To save individual phrases in a phrase window, use the Save Phrases in the Phrase Menu. 

Shortcuts

Toolbar: (the first time you save a file)

Key: F12

Dialog Box Options

File Name

Type a new filename to save a file with a different name or in a different file format.

Use the current name, or select a name in the list to save a document with an existing filename.

Note: A filename can contain up to eight characters and an extension of up to three characters. 
Announce! adds the extension you specify in the Save File As Type box.

Drives

Select the drive in which you want to store the document.

Directories

Select the directory in which you want to store the document.

Save File As Type

Announce! can save files in various file formats. 

Phrase files can be saved as:

VAP (VBase40) files. VAP files are compressed files containing multiple phrases. They are limited to 
a single sampling rate and compression type.

Phrases in voice editor windows can be saved as a new phrase in the original source Phrase window, 
or as individual voice files in these formats:

VOX (compressed ADPCM) files.

LIN 16 bit linear files.

WAV Windows format sound files.

See also

File Formats 



Cut command (Edit menu)
Use this command to remove the selected phrases from a phrase file, or to remove selected samples 
from a voice editor, and to store them on the clipboard.

This command is unavailable if you have no selected text or phrases. 

In order to improve speed of operation, Announce! does not actually copy the data during cut or copy 
operations, but stores a pointer to the file. If this file is subsequently closed, Announce! will prompt 
you before closing the file.

Note that cutting phrases to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+Del



Clear command(Edit Menu)

Use this command to remove selected phrases from a phrase file, or to remove selected samples 
from a voice editor. The data removed will lost unless the window is closed without saving. 

This command is unavailable if you have no selected text or phrases. 

Shortcuts

Toolbar:
Keys: Delete



Copy command (Edit menu)
Use this command to copy selected phrases or samples onto the Clipboard. This command is 
unavailable if you have nothing selected in the active window.

In order to improve speed of operation, Announce! does not actually copy the data during cut or copy 
operations, but stores a pointer to the file. If this file is subsequently closed, Announce! will prompt 
you before closing the file.

Copying a selection to the Clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+Insert



Paste command (Edit menu)

Use this command to insert a copy of the Clipboard contents at the insertion point. This command is 
unavailable if the Clipboard is empty, or if the active window cannot accept the data on the clipboard. 
A voice editor will not accept multiple phrases. 

Shortcuts

Toolbar:
Keys: Shift+Insert



Select All command (Edit menu)

Use this command to select all the phrases in a phrase file, or to select all the samples in a voice 
editor window.



Find (Edit Menu)

Use this command when you have a large phrase file and you are searching for a particular phrase. 
Searching is always case-insensitive.



Sort by Filename (Edit    Menu)
Use this command to alphabetically sort all the phrases in a phrase list by filename 



Sort by Script (Edit    Menu)
Use this command to alphabetically sort all the phrases in a phrase list by phrase script 



Silence (Insert Menu)

Use this command to insert silence into a voice editor window. The silence will be inserted at the 
current selection point. The amount of silence can be adjusted as required.



Tones (Insert Menu)

Use this command to insert a tone into a voice editor window. Click a button to select a standard dtmf 
or call progress tone, or make your own tone. Announce! can generate 2 simultaneous tones, which 
are added together and amplitude modulated (if required) with a third tone. 



Merge Clip (Insert Menu)

Use this command to add the contents of the clipboard to a voice editor window, without affecting the 
timing of the original signal. The clipboard contents are added to the original sound, unlike the Paste 
command which inserts new samples into the waveform. The start time of the new selection can be 
moved in the window by clicking and dragging the mouse in the square in the top left corner of the 
merged samples.    The cursor will change to a rectangle when over this point. You can test the effect 
of this command by choosing the play command, which will prompt you with a dialog to ask if you 
wish to hear the phrase with or without the merged samples.

Save your changes or abandon the merge operation by selecting the Merge command again. This will 
uncheck the Merge menu item, and load the merged samples into the waveform if you choose to save 
changes.

 

ShortCut

Toolbar:



Edit Script (Phrase Menu)

Use this command to change the name of a phrase in a phrase window. Announce! will show a dialog 
into which you can insert or change the script. You can also play the script from this dialog, so that if 
you are updating the script to match an existing voice file, you can type the words as they play on 
your sound device. The loop play mode may also be useful.

ShortCut

Mouse: double click on the name in the phase list window



Edit Filename (Phrase Menu)
Use this command to change the filename of a phrase in a phrase window. Each phrase must have a 
unique filename. If a name conflict occurs, a dialog will appear asking for a new name. The dialog will 
not go away until you type in a unique name for this phrase. Filenames are limited to 8 characters. 
The drive, directory and file extension are assigned by the Save Phrases command and are not 
required in the filename dialog.

ShortCuts

Mouse: double click on the  in the phase list window



Edit Voice (Phrase Menu)

Use this command to open a voice editor window on a phrase in a phrase file. When the voice editor 
window is closed, or saved, the data will be saved back into the phrase file. However the changes will 
not be permanent until the phrase file itself is saved.

ShortCuts

Toolbar:
Mouse: drag the selected item onto the Announce! desktop



Import Voice (Phrase Menu)

Use this command to create a new phrase with the contents of a VOX or WAV file.

ShortCuts:

Drag the file from File Manager and dropping it onto the Phrase window.



Compress (Phrase Menu)

Use this command to convert a phrase or phrases to compressed ADPCM format, using the 
appropriate algorithm for your voice card as specified in the Setup Menu. You cannot convert a 
subphrase to ADPCM.



Decompress (Phrase Menu)

Use this command to convert a phrase or phrases to 16 bit linear format, using the appropriate 
algorithm for your voice card as specified in the Setup Menu. 

Announce! will convert your phrases to linear automatically if you select any of the voice processing 
commands. 

Your phrases will be converted back to compressed ADPCM format when you save as VOX files or as 
VAP (VBase40 ) files, or if you select the Convert to Adpcm    command.





Save Phrases as Files (Phrase Menu)
Phrases in a phrase window can be saved as individual phrase files, using the filename attached to 
each phrase. Phrases are converted to the sampling rate and format appropriate for your voice card.

Announce! will show a file save dialog to allow you to choose the directory to save the files into. All 
phrases will be saved into the same directory.

If the filename for a phrase has not been set, you will be prompted to supply one. You can set up the 
filenames prior to using this command by using the Load Filenames from File    command or the Edit 
Filename    command.



Save Scripts (Phrase Menu)

Use this command to save the phrase scripts in a phrase file to a text file. This file can be modified 
using a text editor and loaded back into the phrase list with the Load Scripts from File command. This 
method is useful if you have a large number of phrases to rename.



Save Filenames to File
Use this command to save the filenames in a phrase file to a text file. This file can be modified using a 
text editor and loaded back into the phrase list with the Load Filenames from File command. This 
method is useful if you have a large number of filenames to rename.



Load Scripts from File (Phrase Menu)

Use this command to set the scripts for all the phrases in a file from a text file containing the desired 
scripts. Each line in the file is used to rename phrases in order starting from the top, until the end of 
file is reached, or until all phrases are renamed.



Load Filenames from File (Phrase Menu)

Use this command to attach filenames to the phrases in a file from a text file which contains the 
desired filenames. The contents of each line in the file is assumed to be a filename. All filenames are 
renamed in order from the top of the file, until the end of the text file or until all phrases have been 
processed. The drive, directory and file extension are assigned by the Save Phrases command and 
are not required in the filename dialog. 

See Also

Using Phrase Filenames 



Pad Silence (Effect Menu)

Use this command to set the amount of silence at the beginning and end of a phrase or phrases. This 
command can be used in both voice editor and phrase file windows.

Announce! will use silence detection to find the start and end of each phrase. If there is more silence 
than specified by the leading and trailing silence parameters set in the dialog, Announce! will shorten 
the silence period to that specified. If there is less silence than specified, Announce! will add silence 
as necessary. 

This command is useful to ensure that phrases can be concatenated with the correct amount of 
silence between each one in order to sound natural.

The Pad Silence dialog allows you to set the silence detection level, and the amount of silence 
required at the start and end of each phrase. We recommend you first experiment with the settings in 
a voice editor window, where Announce! will show you the silence detect level in the window, and the 
points where the start and end of the phrase have been detected. Once you have set up the silence 
level parameter, you can go back to the phrase file window, select all your phrases and perform the 
pad silence operation on all phrases with one command.



Clean Silence (Effect Menu)

This command is used to quieten periods of noisy silence in gaps between words and at the start and 
end of phrases. Announce! uses silence detection to find the start and end of each word or 
subphrase, and inserts complete silence into the gaps. There is a transition period between the end of 
the word and the silence where the previous samples are decayed exponentially to zero to avoid 
unnatural sounding transitions.

The Clean Silence dialog allows you to set the silence detect threshold, and also the minimum 
amount of silence which can be detected as silence. In addition, you can change the period of decay 
at the start and end of each word. The effect of the settings is shown graphically in the window, when 
using this dialog in a voice editor window.

Announce! uses the Loudness Envelope to make the changes. If you select Cancel, Announce! does 
not save changes, but leaves the loudness envelope display in the window. You may then customise 
the envelope using the mouse, before saving changes by selecting Loudness Envelope    in the 
Effects menu.

The Test button allows you to hear the effect of your filter before saving changes.



Filter (Effect Menu)

Use this command to filter a phrase to alter the sound or remove unwanted noises. You can set a 
lower cutoff frequency, an upper cutoff frequency, and the order of the filter, which is a measure of 
how sharp the cutoff will be.

The dialog normally shows the amplitude response of the filter, however the phase response is also 
available by pressing the Show Phase button. 

The Test button allows you to hear the effect of your filter before saving changes.



Echo (Effect Menu)

Use this command to add an echo effect. Often a slight echo (1 echo, delayed 50 ms, -10db decay) is 
enough to add more presence to your prompts. You can set the number of echoes, the amount that 
the level of each echo is reduced by, and the time between echoes. Adding more echoes, with larger 
delays and less decay will produce some strange effects, and may cause clipping to occur.

The Test button allows you to hear the effect of your echo before saving changes.

Once you have found the right parameters for your application, you can select all the phrases in your 
file and process them all with one command.



Fast/Slow (Effect Menu)

Use this command to speed up or slow down a phrase or selection. Announce! does not do pitch 
adjustment, so the pitch of the voice will alter accordingly.

The Test button allows you to hear the effect of your echo before saving changes.



Erase (Effect Menu)

Use this command to silence a portion of the phrase without altering the timing. The selected samples 
are reduced to silence but are not removed.



Louder/Softer (Effect Menu)

Use this command to increase or reduce the gain of a phrase. 

All phrases in a phrase file can be processed with one command. If this command is used in a voice 
editor window, only the gain of the current selection is altered.

The Test button allows you to hear the effect of your echo before saving changes.



Loudness Envelope (Effect Menu)

Use this command in a voice editor window to graphically change the gain of parts of your phrase. 
After you have selected this command, the menu item will be checked, and you will see a green line 
across the center of the window. Also, you will see a scale appear on the left hand side of the window, 
showing the relative gain level. The center line is the default gain of 0dB, or x1. Use the mouse to 
click on the line and drag the line to a new position. The line shows how much the gain will be 
adjusted. It is possible to increase the gain, decrease the gain, and fade in and out. If the envelope 
line is moved above the center line, the level of the signal will be increased, and if the line is moved 
below the center line, it will be reduced.

To hear the effect of your envelope changes, use the Play command. This will give you the option to 
hear the clip with or without the envelope changes. Announce! will then prompt you to save the 
envelope changes when you turn off envelope mode by choosing the envelope item again.

 Here is part a word that is being operated on by the loudness envelope. The end of the word will be 
louder than before, giving it more emphasis.



SampleRate (Effect Menu)

Use this command to change the sampling rate of a phrase. Announce! will show a dialog containing 
a drop-down selection box to allow you to select one of the most common sampling rates, or type 
your desired sampling rate into the edit box. 

Note that when reducing the sampling rate of a phrase from a higher frequency to a lower one, it is 
advisable to filter the samples first, to avoid unwanted noises appearing in the phrase. Announce! will 
prompt you to do this if you do not set the anti-alias check box in the dialog, and anti-alias filtering is 
required. Announce! will use the default anti-alias filter for this purpose. Anti-aliasing is required due 
to an effect of digitaly sampling a waveform. 

Sampling rate conversion runs faster if the new sampling rate is an exact multiple of the previous one.

Shortcuts

StatusBar: RATE button in StatusBar .





Use voice card / Use sound card (Sound Menu)

Use voice card
Use sound card 

Use these commands to select which device to use for play and record operations. If you have both a 
Windows sound card and a Voice card, you can easily test the sound quality with both systems by 
using this menu. 

The currently active playback device is shown with a check mark on the menu.



Record (Sound Menu)

Use this command to start a recording session. Announce! will show the record dialog 

This dialog is different depending on whether you have chosen to use a voice card or a sound card, 
and whether the active window is a phrase list or a voice editor. 

Phrase list window:

With both cards, the record dialog will show you the script for the currently selected phrase. You can 
record directly into the phrase. If you change the script for the phrase, a new phrase will be created. 
You can scroll back and forth through the phrases using the Last and Next buttons.

Voice Editor window:

When you choose record from a voice editor window, Announce! will show a dialog which will allow 
you to record a single phrase into the voice editor window. The phrase will be inserted at the cursor.

See Starting a new project .

 Record Dialog 

Shortcuts

Toolbar:



Play Clip (Sound Menu)

Use this command to play a phrase from a phrase file window, or to play the entire clip in a voice 
editor window. Once playing, the command can be terminated by clicking on the stop button, 
choosing stop from the Sound menu, pressing the escape key, or just clicking in a window. When 
playing to an 8 bit sound device, Announce! will warning if your waveform has exceeded the 
maximum value allowable.

Shortcuts

Toolbar:

Mouse: double click on the  icon to play. Click anywhere to stop play.



Play Selection (Sound Menu)

Use this command to play a selection from a phrase in a voice editor window. Once playing, the 
command can be terminated by clicking on the stop button or choosing stop from the Sound menu. 
When playing to an 8 bit sound device, Announce! will warn you if your waveform has exceeded the 
maximum value allowable.

Shortcuts

Toolbar:





Stop (Sound Menu)

Use this command to stop a play function. 

Shortcuts

Toolbar:
Mouse: click in a window



Wait for Call (Play Menu)

Use this command to make a connection through the phone system to your voice card from another 
phone. Announce! will go onhook on the voice card line, and wait for an incoming ring. If a ring is 
received, Announce! will go offhook on the line to answer the call. If the cancel button is pressed, 
Announce! will go back offhook on the line.



Play Repeat Mode

This command will set Announce! into a mode where all play commands continously loop 
until terminated by the stop command. This is useful when evaluating short phrases, and 
when transcribing pre-recorded phrases into script text.



Record Dialog

fields:

Last Button:

This button is available when recording to a phrase list. It will step you back through your list of 
phrases.

Next Button:

This button is available when recording to a phrase list. It will step you back forwards your list of 
phrases.

Record Button:

This button starts the record process. If using a sound card, and silence detection is enabled, 
recording will not start until you start talking.

Stop Button:

This button stops a phrase currently being recorded. If silence detect is enabled, Announce! will stop 
speech detection until Record or Autorecord is pressed.

Autorecord Button:

This button is only available when recording into a phrase list from a sound card. It will allow you to 
automatically step through the phrases in a phrase list recording each one. This speeds up the 
recording process. If you make a mistake, you can use the stop button and back up using the Last 
button to re-record a previous phrase.

Auto silence detect: check box

This is available if you are recording from a Windows sound card. If you check this box, recording will 
not start until speech is detected. 

Silence Level meter and Scroll bar

This gives visual feedback of the sound level being recieved. In addition. the scroll bar sets the 
threshold for silence detection. If you are using silence detection, and the beginning or ends of your 
phrases are not being recorded, try reducing this level, or increasing the sound level from your sound 
card.

Shortcuts
Toolbar:  



Windows Sound Card (Setup Menu)

Use this command to tell Announce! about your Windows sound card, and the parameters specific to 
recording with a sound card. When using recording with silence detection, you may need to alter the 
silence detection parameters to ensure good pause detection. 

Non-silence detect time

Increasing the non-silence detect time will help to remove coughs and other noises in between 
prompts, but you may also miss short prompts such as "one", or "two".

Silence detect time

Increasing the silence detect time will ensure that pauses between phrases in a larger prompt, such 
as "press 1 for support,<pause> press 2 for sales" will not be detected as 2 separate prompts. 
However the minimum pause between each prompt recording must be greater than the silence detect 
time or you will have more than one prompt in each phrase. (this is not a big problem however since 
you can easily split them up afterwards with the Split Phrase command)

Record Frequency

Most Windows sound cards support recording at different sampling rates. We recommend setting up 
your Windows sound card to sample at the same sampling rate as your voice card. However, some 
sound cards will only record at specific frequencies (usually 11025Hz and 22100 Hz). In this case    
the recordings will be converted to the voice card frequency when the files are saved as voice files.

 Sample rate conversion will be much faster if you use an exact multiple of the final sampling rate.

You can select one of the provided sampling rates from the drop-down selection box, or you can type 
your desired sampling rate into the edit box. 

Announce! supports all Windows sound cards with Windows 3.1 sound drivers.

When using a sound card, use the manufacturers mixer application to select the correct input port and 
the record level.



Voice Card (Setup Menu)
Use this command to tell Announce! about your Windows voice card.    It is important to correctly 
specify all the parameters in this dialog for your voice card to work correctly.

Voice Card channel

Dialogic channels are numbered from 1, and Pika channels are numberered    from 0.

Record Silence Timeout

This field sets the maximum amount of silence in seconds before the voice card will stop recording. If 
set to zero, recordings will not terminate on silence.

H/W interrupt

Use this setting to tell Announce! which hardware interrupt is used by the Dialogic driver. If you 
specified the hardware interrupt when you loaded D40DRV.EXE, then this setting may be left at 0.

Wait for ring before offhook

If this box is checked, Announce! will start up with the voice card line on-hook. When it detects an 
incoming ring, Announce! will go offhook on that line See also Wait for Ring in the Sound menu (page 
46). 

Use local phone

You can choose whether to use the local phone if you are using an PIKA AVA-1B with the local phone 
option, and whether to use the microphone input or the phone port for recording. 

Compression Type

Use this command to set up the type of compression and decompression to use when working with 
compressed voice files.    Announce! can compress and decompress both Dialogic format and PIKA 
format files. 

Sampling Rate

Announce! also needs to know the sampling rate used by your voice card. You can select one of the 
provided sampling rates from the drop-down selection box, or type the sampling rate into the edit box. 

Extensions

In addition, you can change the default file extensions to be used for voice files. These extensions are 
used in the file dialog boxes when saving to compressed voice file format.



Font (Setup Menu)

Use this command to change the font used by all windows. The color of the font used in voice editor 
windows is selected in the waveform colors setup. 



Waveform Display (Setup Menu)

Use this command to enable an alternative method of the graphically showing the samples in voice 
editor window. The normal Announce! method for displaying samples in a voice editor window is to 
take the average of the samples corresponding to each pixel on the screen. Using the max envelope 
will always show the largest valued samples. This is sometimes useful to find whether clipping may 
take place on record. 



Waveform Colors (Setup Menu)
Use this dialog to change the colors used by Announce! in voice editor windows.    Announce! 
normally uses the Windows system colors for drawing the waveforms, cursors and other graphical 
objects in the voice editor window, and in the phrase list window. You can change the colors of the 
different objects in a voice editor window by selected an object using the radio button, and then 
choosing the color associated with that object from the color boxes. Note there are actually 2 colors 
associated with some items such as cursors, which are displayed superimposed on top of the display. 
A different color will be shown for these items depending on whether they are over a white portion of 
the screen or a black portion. This ensures that the cursor is always visible. 





File Formats

VBase40 files (*.vap) 

VBase40 is a common format for storing compressed ADPCM files. In addition to the data, VBase40 
files store the sampling rate used for all phrases, a name for each file and an index into the phrase 
data. See VBase40 file format. 

ADPCM Voice Files      (*.vox, *.voi)

These are normally individual phrases stored in compressed adpcm format. There is no formatting 
information in these files. Sampling rate and compression type are assumed to be as set up in the 
Voice card Setup Menu.

Windows Sound Files      (*.wav)

These are standard Windows sound files. These files contain information about the sampling rate and 
compression type, and mono/stereo. Announce! can open all mono and stereo WAV files, both 8 and 
16 bit, with sampling rate of 32kHz or less. When opening 8 bit sound wave files, Announce! scales 
the 8 bit samples to normal ADPCM amplitude. When saving to a 8 bit wave file, or when playing to 
an 8 bit play device, Announce! will scale the samples back to their original value. Announce! will 
warn you if any part of your waveform has exceeded the allowable value for 8 bit samples during play 
or save operations. When opening stereo wav files, Announce! adds the two channels to convert to 
mono, and reduces the amplitude to avoid clipping.



VBase40 File Format

A VBASE40 phrase file format is broken into three sections:

1) Header

2) Index

3) Data

Header

The file header contains various pieces of information about the phrase file. The following C language 
structure definition describes this header:

struct PFILEHDR {

long max_phrases; /* maximum # of prompts in the header*/
long sampling_rate;/* sampling frequency */
long phrases; /* # of prompts in use */
long reserved_1;
long bytes_in_use; /* file size */
long reserved_2;

} phdr;

The header occupies the first 24 bytes of the phrase file.

Index

The phrase file index is made up of phdr.max_phrases copies of the following C language structure 
definition:

struct PFILEIDX {

long phr_offset; /* offset (in bytes) of phrase */
long length; /* length (in bytes) of phrase */
long text_offset; /* offset of text record */

} pindex;

There is one index entry for each phrase.

Data

The phrases and text records are stored in the remainder of the file. Phrases are accessed with the 
phr_offset and length members of the appropriate pindex structure. Since the data in a voice phrase 
is binary, there is no special terminating character to mark the end of a phrase.

Text records are stored in ASCII format and are terminated by the ASCII NUL character ('\0').




